## Contents

**Chapter 1**  
3 iPod shuffle Basics  
4 iPod shuffle at a Glance  
4 Using the iPod shuffle Controls  
5 Connecting and Disconnecting iPod shuffle  
6 Charging the Battery  
7 Status Lights

**Chapter 2**  
9 Loading and Playing Music  
9 About iTunes  
10 Importing Music into Your iTunes Library  
12 Organizing Your Music  
13 Loading Music onto iPod shuffle  
16 Playing Music

**Chapter 3**  
19 Storing Files on iPod shuffle  
19 Using iPod shuffle as an External Disk

**Chapter 4**  
21 iPod shuffle Accessories  
21 Apple Earphones  
22 iPod shuffle Dock  
22 iPod USB Power Adapter  
22 Available Accessories

**Chapter 5**  
23 Tips and Troubleshooting  
26 Updating and Restoring iPod shuffle Software

**Chapter 6**  
27 Safety and Handling  
27 Important Safety Information  
29 Important Handling Information

**Chapter 7**  
30 Learning More, Service, and Support

**Index**  
33
Congratulations on purchasing iPod shuffle. Read this chapter to learn about the features of iPod shuffle, how to use its controls, and more.

To use iPod shuffle, you put songs and other audio files on your computer and then load them onto iPod shuffle.

Use iPod shuffle to:
- Load songs for listening on the go
- Listen to podcasts, downloadable radio-style shows delivered over the Internet
- Listen to audiobooks purchased from the iTunes Store or audible.com
- Store or back up files and other data, using iPod shuffle as an external disk
Using the iPod shuffle Controls

The simple controls make it easy to play songs, audiobooks, and podcasts on iPod shuffle.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn iPod shuffle on or off</td>
<td>Slide the power switch (green indicates iPod shuffle is on).</td>
</tr>
<tr>
<td>Play</td>
<td>Press Play/Pause (►).</td>
</tr>
<tr>
<td>Pause</td>
<td>Press Play/Pause (►).</td>
</tr>
<tr>
<td>Change the volume</td>
<td>Press Volume Up (↕) or Volume Down (↔).</td>
</tr>
<tr>
<td>Set the play order</td>
<td>Slide the shuffle switch (↔️ to shuffle, ➡️ to play in order).</td>
</tr>
<tr>
<td>Skip to the next track</td>
<td>Press Next/Fast-forward (➡️).</td>
</tr>
<tr>
<td>Start a track over</td>
<td>Press Previous/Rewind (⬅️).</td>
</tr>
<tr>
<td>Play the previous track</td>
<td>Press Previous/Rewind (⬅️) twice.</td>
</tr>
<tr>
<td>Go to the first track</td>
<td>Press Play/Pause (►) three times quickly.</td>
</tr>
<tr>
<td>Fast-forward or rewind</td>
<td>Press and hold Next/Fast-forward (➡️) or Previous/Rewind (⬅️).</td>
</tr>
<tr>
<td>Disable the iPod shuffle buttons</td>
<td>Press Play/Pause (►) for about three seconds (until the status light blinks orange three times). Repeat to reenable the buttons (the status light blinks green three times).</td>
</tr>
<tr>
<td>Reset iPod shuffle</td>
<td>Remove iPod shuffle from the Dock. Turn iPod shuffle off, wait 5 seconds, and then turn it back on again.</td>
</tr>
<tr>
<td>Find the iPod shuffle serial number</td>
<td>Look on the notch underneath the clip on iPod shuffle. Or, in iTunes (with iPod shuffle connected to your computer), select iPod shuffle in the Source pane and click the Settings tab.</td>
</tr>
</tbody>
</table>
Connecting and Disconnecting iPod shuffle
Connect iPod shuffle to your computer to load songs and other audio files, and to charge the battery. Disconnect iPod shuffle when you're done.

Connecting iPod shuffle
To connect iPod shuffle to your computer:
- Plug the included iPod shuffle Dock into a USB port on your computer. Then put iPod shuffle in the Dock.

Note: Connect the Dock to a high-power USB port to charge the battery. A USB 2.0 port is recommended. Do not use the USB port on your keyboard.

The first time you connect iPod shuffle to your computer, the iPod Setup Assistant helps you configure iPod shuffle and sync it with your iTunes library.

Important: Once you've synced iPod shuffle with the iTunes library on a computer, a message appears whenever you connect iPod shuffle to another computer, asking if you want to sync with the iTunes library on the new computer. Click Cancel if you want to keep the current music content on iPod shuffle. Or, click Transfer Purchases to keep the contents on iPod shuffle and copy the purchased songs on it to the iTunes library on the new computer. See iTunes Help for more information.

Disconnecting iPod shuffle
It's important not to disconnect iPod shuffle from your computer while audio files are being loaded or when iPod shuffle is being used as an external disk. You can see if it's OK to disconnect iPod shuffle by looking at the top of the iTunes window or by checking the iPod shuffle status light.

Important: If you see the “Do not disconnect” message in iTunes or if the status light on iPod shuffle is blinking orange, you must eject iPod shuffle before disconnecting it. Otherwise, you could damage files on iPod shuffle.

If you enable iPod shuffle for disk use (see page 19), you must always eject iPod shuffle before disconnecting it.
To eject iPod shuffle:
- In iTunes, click the Eject (⏏) button next to iPod shuffle in the Source pane.

If you're using a Mac, you can also eject iPod shuffle by dragging the iPod shuffle icon on the desktop to the Trash.

If you're using a Windows PC, you can also eject iPod shuffle by clicking the Safely Remove Hardware icon in the Windows system tray and selecting iPod shuffle.

To disconnect iPod shuffle:
- Remove iPod shuffle from the dock.

Charging the Battery
iPod shuffle has an internal, rechargeable battery.

For best results, charge the battery fully the first time you use iPod shuffle. A depleted battery can be 80-percent charged in about two hours and fully charged in about four hours.

If iPod shuffle isn’t used for a while, the battery might need to be recharged.

To charge the battery using your computer:
- Connect iPod shuffle to a high-power USB port on your computer using the included iPod shuffle Dock. The computer must be turned on and not in sleep mode (some models of Macintosh can charge iPod shuffle while in sleep mode).

When the battery is charging, the status light on iPod shuffle is orange. When the battery is fully charged, the status light turns green.

Note: If iPod shuffle is being used as a disk (see page 19) or if iTunes is loading songs or settings onto iPod shuffle, the status light blinks orange to let you know that you must eject iPod shuffle before disconnecting it.

If you don’t see the status light, iPod shuffle might not be connected to a high-power USB port. Try another USB port on your computer.

Note: You can load music while the battery is charging.

If you want to charge iPod shuffle when you’re away from your computer, you can connect iPod shuffle to an iPod USB Power Adapter, available at www.apple.com.
To charge the battery using an iPod USB Power Adapter:
1. Connect the AC plug adapter to the power adapter (they might already be connected).
2. Plug the USB connector of the iPod shuffle Dock into the power adapter.
3. Plug the power adapter into a working electrical outlet.
4. Put iPod shuffle in the dock.

You can disconnect and use iPod shuffle before it is fully charged.

Note: Rechargeable batteries have a limited number of charge cycles. Battery life and number of charge cycles vary by use and settings. For information, go to www.apple.com/batteries.

Checking the Battery Status
When you turn iPod shuffle on, or disconnect it from your computer or power adapter, the status light tells you approximately how much charge is in the battery. See the table in the following section. If iPod shuffle is already on, you can check the battery status without interrupting playback by quickly switching iPod shuffle off and then on again.

Status Lights
iPod shuffle has two status lights, one on the top and one on the bottom, that let you know when you’ve pressed a button, the state of the battery, that iPod shuffle is enabled as a disk, or if there’s something wrong.
### Turning on or disconnecting

<table>
<thead>
<tr>
<th>LED State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Good charge (30% – 100%)</td>
</tr>
<tr>
<td>Orange</td>
<td>Low charge (10% – 30%)</td>
</tr>
<tr>
<td>Red</td>
<td>Very low charge (&lt; 10%)</td>
</tr>
<tr>
<td>No light</td>
<td>No charge</td>
</tr>
<tr>
<td>Alternating green and two orange (10 seconds)</td>
<td>ERROR: iPod shuffle must be restored</td>
</tr>
</tbody>
</table>

### Connected

<table>
<thead>
<tr>
<th>LED State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orange (continuous)</td>
<td>Charging</td>
</tr>
<tr>
<td>Green (continuous)</td>
<td>Fully charged</td>
</tr>
<tr>
<td>Blinking orange (continuous)</td>
<td>Do not disconnect (iTunes is syncing, or iPod shuffle is enabled for disk use)</td>
</tr>
</tbody>
</table>

### Pressing buttons

<table>
<thead>
<tr>
<th>Pressing and holding</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Play (▶)</td>
</tr>
<tr>
<td>Green, then three orange</td>
<td>Pause (▶)</td>
</tr>
<tr>
<td>Volume up (+) or down (−)</td>
<td>Volume limit reached</td>
</tr>
<tr>
<td>Volume up (+) or down (−)</td>
<td>Volume limit reached</td>
</tr>
<tr>
<td>Previous track (▶)</td>
<td>Rewind (▶)</td>
</tr>
<tr>
<td>Next track (▶)</td>
<td>Fast forward (▶)</td>
</tr>
<tr>
<td>No action (buttons are disabled)</td>
<td>ERROR: No music loaded</td>
</tr>
</tbody>
</table>

### While iPod shuffle is playing

<table>
<thead>
<tr>
<th>LED State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blinking red (continuous)</td>
<td>Battery nearly discharged</td>
</tr>
</tbody>
</table>
Loading and Playing Music

With iPod shuffle, you can take your music collection with you wherever you go. Read this chapter to learn about loading music and listening to iPod shuffle.

You use iPod shuffle by importing songs, audiobooks, and podcasts (radio-style audio shows) to your computer and then loading them onto iPod shuffle. Read on to learn more about the steps in this process, including:

- Getting music from your CD collection, hard disk, or the iTunes Store (part of iTunes and available in some countries only) into the iTunes application on your computer
- Organizing your music and other audio into playlists
- Loading songs, audiobooks, and podcasts onto iPod shuffle
- Listening to music or other audio on the go

About iTunes

iTunes is the software you use to sync music, audiobooks, and podcasts with iPod shuffle. When you connect iPod shuffle to your computer, iTunes opens automatically.

This guide explains how to use iTunes to import songs and other audio to your computer, create personal compilations of your favorite songs (called playlists), load iPod shuffle, and adjust iPod shuffle settings.

iTunes also has many other features. For information, open iTunes and choose Help > iTunes Help.
Importing Music into Your iTunes Library
To listen to music on iPod shuffle, you first need to get that music into your iTunes library on your computer.

There are three ways to get music into your iTunes library:
- Buy music and audiobooks or download podcasts online from the iTunes Store.
- Import music from audio CDs.
- Add music and other audio that’s already on your computer.

Buying Songs and Downloading Podcasts Using the iTunes Store
If you have an Internet connection, you can easily purchase and download songs, albums, and audiobooks online using the iTunes Store. You can also subscribe to and download podcasts, radio-style audio shows.

To purchase music online using the iTunes Store, you set up an Apple account in iTunes, find the songs you want, and then buy them. If you already have an Apple account, or if you have an America Online (AOL) account (available in some countries only), you can use that account to sign in to the iTunes Store and buy songs.

To sign in to the iTunes Store:
- Open iTunes and then:
  - If you already have an iTunes account, choose Store > Sign In.
  - If you don’t already have an iTunes account, choose Store > Create Account and follow the onscreen instructions to set up an Apple account or enter your existing Apple account or AOL account information.

To find songs, audiobooks, and podcasts:
You can browse or search the iTunes Store to find the album, song, or artist you’re looking for. Open iTunes and click iTunes Store in the Source pane.
- To browse the iTunes Store, choose a music genre from the Choose Genre pop-up menu, click one of the displayed releases or songs, or click Browse in the main iTunes Store window.
- To browse for podcasts, click the Podcasts link in the main iTunes Store window.
- To search the iTunes Store, type the name of an album, song, artist, or composer in the Search iTunes Store field.
• To narrow your search, type something in the Search iTunes Store field, press Return or Enter on your keyboard, and then click items in the Search Bar. For example, to narrow your search to song titles and albums, click MUSIC.

• To search for a combination of items, click Power Search in the iTunes Store window.

• To return to the main page of the iTunes Store, click the Home button in the top-left corner of the main iTunes Store window.

To buy a song, album, or audiobook:
1 Click iTunes Store in the Source pane, and then find the item you want to buy.
   You can double-click a song or other item to listen to a portion of it and make sure it’s what you want.
2 Click Buy Song, Buy Album, or Buy Book.
   The item is downloaded to your computer and charged to the credit card listed in your Apple or AOL account.

To download or subscribe to a podcast:
1 Click iTunes Store in the Source pane.
2 Click the Podcasts link on the left side of the main page in the iTunes Store.
3 Browse for the podcast you want to download.
   • To download a single podcast episode, click the Get Episode button next to the episode.
   • To subscribe to a podcast, click the Subscribe button next to the podcast graphic. iTunes downloads the most recent episode. As new episodes become available, they are automatically downloaded to iTunes when you connect to the Internet.

Importing Music from Your Audio CDs into iTunes
Follow these instructions to get music from your CDs into iTunes.

To import music from an audio CD into iTunes:
1 Insert a CD into your computer and open iTunes.
   If you have an Internet connection, iTunes gets the names of the songs on the CD from the Internet (if available) and lists them in the window.
   If you don’t have an Internet connection, you can import your CDs and, later, when you’re connected to the Internet, choose Advanced > Get CD Track Names. iTunes will get the track names for the imported CDs.
   If the CD track names aren’t available online, you can enter the names of the songs manually. See “Entering Names of Songs and Other Details” on page 12.

With song information entered, you can browse for songs in iTunes by title, artist, album, and more.
2 Click to remove the checkmark next to any song you don’t want to import from the CD.

3 Click the Import CD button. The display area at the top of the iTunes window shows how long it will take to import each song.

   By default, iTunes plays songs as they are imported. If you’re importing a lot of songs, you might want to stop the songs from playing to improve performance.

4 To eject the CD, click the Eject (⏏) button.

5 Repeat these steps for any other CDs with songs you want to import.

**Entering Names of Songs and Other Details**

You can manually enter song titles and other information, including comments, for songs and other items in your iTunes library.

**To enter CD song titles and other information manually:**

1 Select the first track on the CD and choose File > Get Info.

2 Click Info.

3 Enter the song information.

4 Click Next to enter information for the next track.

**Adding Songs Already on Your Computer to Your iTunes Library**

If you have digital music files such as MP3s already on your computer, you can easily add them to your iTunes library.

**To add songs on your computer to your iTunes library:**

- Drag the folder or disk containing the audio files to the LIBRARY heading in the iTunes Source pane (or choose File > Add to Library and select the folder or disk). If iTunes supports the song file format, the songs are automatically added to your iTunes library.

   You can also drag individual song files to iTunes.

**Note:** Using iTunes for Windows, you can convert unprotected digital music files created with Windows Media Player to an iTunes-compatible file format, such as AAC or MP3. This can be useful if you have music encoded in WMA format. For more information, open iTunes and choose Help > iTunes Help.

**Organizing Your Music**

Using iTunes, you can organize songs and other items into lists, called playlists, in any way you want. For example, you can make playlists with songs to listen to while exercising or playlists with songs for a particular mood.

You can also make Smart Playlists that update automatically based on rules you choose. When you add songs to iTunes that match the rules, they automatically get added to the Smart Playlist.
You can make as many playlists as you like using any of the songs in your iTunes library. Adding a song to a playlist or later removing it doesn’t remove it from your iTunes library.

**To make a playlist in iTunes:**
1. Click the Add (+) button or choose File > New Playlist.
2. Type a name for the playlist.
3. Click Music in the LIBRARY list, and then drag a song or other item to the playlist.
   
   To select multiple songs, hold down the Shift key or the Command (⌘) key on a Mac, or the Shift key or the Control key on a Windows PC, as you click each song.

**To make a Smart Playlist:**
- Choose File > New Smart Playlist and define the rules for your playlist.

**Loading Music onto iPod shuffle**
After your music is imported and organized in iTunes, you can easily load it onto iPod shuffle.

You set how music is loaded from iTunes onto iPod shuffle by connecting iPod shuffle to your computer, selecting iPod shuffle in the Source pane, and configuring options at the bottom of the Contents pane. Additional options for loading music and using iPod shuffle appear in the Settings pane.

**Autofilling iPod shuffle**

iTunes can automatically load a selection of your songs onto iPod shuffle with the click of a button. You can choose your entire library or a specific playlist to gets songs from, and set other options for Autofill.

**To autofill music onto iPod shuffle:**
1. Connect iPod shuffle to your computer.
2. Select iPod shuffle from the list of devices in the Source pane.
3. Click the Contents tab.
4 Choose the playlist you want to autofill from using the pop-up menu.
   To autofill music from your entire library, choose Music.

5 Select which of the following options you want:
   * Choose items randomly: iTunes shuffles the order of songs as it loads them onto iPod shuffle. If this option is not selected, iTunes downloads songs in the order they appear in your library or selected playlist.
   * Choose higher rated items more often: iTunes autofills the songs you listen to most.
   * Replace all items when Autofilling: iTunes replaces the songs on iPod shuffle with the new songs you've chosen. If this option is not selected, songs you've already loaded onto iPod shuffle remain and iTunes selects more songs to fill the available space.

6 Click Autofill.

   While music is being loaded from iTunes onto iPod shuffle, the iTunes status window shows the progress. When the autofill is done, a message in iTunes says “iPod update is complete.”

**Limiting Autofill to Items Checked in Your iTunes Library**

You can set iTunes to autofill only items that are checked in your iTunes library. Items that you've deselected will be ignored.

**To limit autofill to checked items:**
1 Connect iPod shuffle to your computer.
2 When iPod shuffle appears in the iTunes window, select it.
3 Click the Settings tab.
4 Select “Only update checked songs.”
5 Click Apply.

**Loading Songs, Audiobooks, and Podcasts Manually**

You can load songs and playlists onto iPod shuffle manually. If you want to load audiobooks and podcasts onto iPod shuffle, you must load them manually.

**To load a song or other item onto iPod shuffle:**
1 Connect iPod shuffle to your computer.
2 In iTunes, select your library or a playlist in the Source pane.
3 Drag the song or other item to the iPod shuffle in the Source pane.
   You can also drag entire playlists to load them onto iPod shuffle.
Arranging the Order of Songs on iPod shuffle
Once songs are loaded onto iPod shuffle, you can arrange the order of the songs in the same way you can with any playlist in iTunes.

To arrange the order of songs on iPod shuffle:
1. In iTunes, select iPod shuffle in the Source pane.
2. Click the Contents tab.
3. Click the blank header above the first column to arrange the songs by number.
4. Drag the songs to the order you want.

Fitting More Songs onto iPod shuffle
If you've imported songs into iTunes at higher bit-rate formats, such as AIFF, you can set iTunes to automatically convert songs to 128 kbps AAC files as they are loaded onto iPod shuffle. This does not affect the quality or size of the songs in iTunes.

Note: Songs in formats not supported by iPod shuffle, such as Apple Lossless, must be converted if you want to load them onto iPod shuffle. For more information about formats supported by iPod shuffle, see “If you can't load a song or other item onto iPod shuffle” on page 24.

To convert higher bit rate songs to AAC files:
1. In iTunes, select iPod shuffle in the Source pane.
2. Click the Settings tab.
3. Select “Convert higher bit rate songs to 128 kbps AAC.”
4. Click Apply.

Removing Songs and Other Items from iPod shuffle
You can have iTunes automatically replace items on iPod shuffle when you load items using Autofill. You can also remove items from iPod shuffle manually.

To automatically replace items on iPod shuffle when autofilling:
1. In iTunes, select iPod shuffle in the Source pane.
2. Select the Contents tab.
3. Make sure “Replace all items when Autofilling” is selected.

To remove a song or other item from iPod shuffle:
1. In iTunes, select iPod shuffle in the Source pane.
2. Select a song or other item on iPod shuffle and press the Delete or Backspace key on your keyboard.

Manually removing a song or other item from iPod shuffle does not delete the song from your iTunes library.
Playing Music
After you load iPod shuffle with music and other audio, you can listen to it.

To listen to the songs and other items on iPod shuffle.
1 Plug the earphones into iPod shuffle and place the earbuds in your ears.
2 Press Play/Pause (● ●).

Press Volume Up (↑) or Volume Down (↓) to adjust the volume. Take care not to turn the volume up too high. See “Setting the Maximum Volume Limit” on page 17.

**WARNING:** Read all safety instructions about avoiding hearing damage on page 28 before use.

For a summary of the iPod shuffle controls, see “Using the iPod shuffle Controls” on page 4.

**Note:** If you’re listening to an audiobook, set the shuffle switch to repeat (●) so that the chapters play in order.

Setting iPod shuffle to Shuffle Songs or Play Songs in Order
You can set iPod shuffle to shuffle songs or play them in order.

**To set iPod shuffle to shuffle:**
- Slide the shuffle switch to shuffle (● ●).

**To set iPod shuffle to play songs in order:**
- Slide the shuffle switch to repeat (● ●).

Setting Songs to Play at the Same Volume Level
The loudness of songs and other audio may vary depending on how the audio was recorded or encoded. iTunes can automatically adjust the volume of songs, so they play at the same relative volume level. You can set iPod shuffle to use the iTunes volume settings.

**To set iTunes to play songs at the same sound level:**
1 In iTunes, choose iTunes > Preferences if you are using a Mac, or choose Edit > Preferences if you are using a Windows PC.
2 Click Playback and select Sound Check.
To set iPod shuffle to use the iTunes volume settings:
1 Connect iPod shuffle to your computer.
2 When iPod shuffle appears in the iTunes window, select it.
3 Click the Settings tab.
4 Select Enable Sound Check.
5 Click Apply.

Important: If you have not turned on Sound Check in iTunes, setting it on iPod shuffle has no effect.

Setting the Maximum Volume Limit
You can set a limit for the maximum volume on iPod shuffle. You can also set a password in iTunes to prevent this setting from being changed by someone else.

If you’ve set a volume limit on iPod shuffle, the status link blinks orange three times if you try to increase the volume beyond the limit.

To set the maximum volume limit for iPod shuffle:
1 Set iPod shuffle to the desired maximum volume.
2 Connect iPod shuffle to your computer.
3 When iPod shuffle appears in the iTunes window, select it.
4 Click the Settings tab.
5 Select “Limit maximum volume.”
6 Drag the slider to the desired maximum volume.
   The initial slider setting shows the volume the iPod shuffle was set to when you selected the “Limit maximum volume” checkbox.
7 To require a password to change this setting, click the lock and enter a password.
   If you set a password, you must enter it before you can change or remove the maximum volume limit.

Note: The volume level may vary if you use different earphones or headphones.
To remove the maximum volume limit:
1 Connect iPod shuffle to your computer.
2 When iPod shuffle appears in the iTunes window, select it.
3 Click the Settings tab.
4 Deselect “Limit maximum volume.”
   Enter the password, if required.

Note: If you forget the password, you can restore iPod shuffle. See “Updating and Restoring iPod shuffle Software” on page 26 for more information.

Disabling and Enabling the iPod shuffle Buttons
You can disable the buttons on iPod shuffle so that nothing happens if they are pressed accidentally.

To disable the iPod shuffle buttons:
- Press and hold Play/Pause (►) for three seconds.
  The status light glows green, and then blinks orange three times when the buttons become disabled. If you press a button when the buttons are disabled, the status light blinks orange once.

To reenable the buttons:
- Press and hold Play/Pause (►) again for three seconds.
  The status light glows orange, and then blinks green three times when the buttons become enabled.
Storing Files on iPod shuffle

Use iPod shuffle to carry your data as well as your music.

Read this chapter to find out how to use iPod shuffle as an external disk.

Using iPod shuffle as an External Disk
You can use iPod shuffle as an external disk to store data files.

Note: To load iPod shuffle with music and other audio that you want to listen to, you must use iTunes. You cannot play audio files that you copy to iPod shuffle using the Macintosh Finder or Windows Explorer.

To enable iPod shuffle as an external disk:
1. In iTunes, select iPod shuffle in the Source pane.
2. Click the Settings tab.
3. In the Options section, select “Enable disk use.”
   Note: You may need to scroll down to see the disk settings.
4. Adjust the slider to set how much space to reserve for songs versus data.
5. Click Apply.

When you use iPod shuffle as an external disk, the iPod shuffle disk icon appears on the desktop on the Mac, or as the next available drive letter in Windows Explorer on a Windows PC.

Transferring Files Between Computers
When you enable disk use on iPod shuffle, you can transfer files from one computer to another. iPod shuffle is formatted as a FAT-32 volume, which is supported by both Macs and PCs. This allows you to use iPod shuffle to transfer files between computers with different operating systems.
To transfer files between computers:

1. After enabling disk use on iPod shuffle, connect it to the computer you want to get files from.

   **Important:** When you connect iPod shuffle to a different computer (or different user account on your computer), a message asks if you want to erase iPod shuffle and sync with the new iTunes library there. Click Cancel if you don’t want to delete the current music content on iPod shuffle.

2. Using the computer’s file system (the Finder on a Mac, Windows Explorer on a PC), drag the files you want to your iPod shuffle.

3. Disconnect iPod shuffle, and then connect it to the other computer.

   Again, click Cancel if you don’t want to delete the current music contents on iPod shuffle.

4. Drag the files from iPod shuffle to a disk on the new computer.

**Preventing iTunes from Opening Automatically**

You can keep iTunes from opening automatically when you connect iPod shuffle to your computer.

**To prevent iTunes from opening automatically:**

1. Connect iPod shuffle to your computer.

2. When iPod shuffle appears in the iTunes window, select it.

3. Click the Settings tab.

4. In the Options section, deselect “Open iTunes when this iPod is connected.”

5. Click Apply.
iPod shuffle Accessories

iPod shuffle comes with earphones and an iPod shuffle Dock.

Learn about your Apple earphones, the iPod shuffle Dock, and other accessories available for iPod shuffle.

Apple Earphones
iPod shuffle comes with a pair of high-quality earphones.

To use the earphones:
- Plug the earphones into the Headphones port. Then place the earbuds in your ears as shown.

WARNING: Read all safety instructions about avoiding hearing damage on page 28 before use.
iPod shuffle Dock
iPod shuffle comes with an iPod shuffle (second generation) Dock, which you use to connect iPod shuffle to your computer and other USB devices. See “Connecting and Disconnecting iPod shuffle” on page 5.

iPod USB Power Adapter
The iPod USB Power Adapter is an optional accessory that allows you to charge iPod shuffle when you’re away from your computer.

Available Accessories
To purchase iPod shuffle accessories, go to www.apple.com/ipodstore.

Available accessories include:
• Apple iPod In-Ear Headphones
• iPod shuffle (second generation) Dock
• iPod USB Power Adapter
Most problems with iPod shuffle can be solved quickly by following the advice in this chapter.

**The 5 Rs: Reset, Retry, Restart, Reinstall, Restore**
Remember these five basic suggestions if you have a problem with iPod shuffle. Try these steps one at a time until the problem is resolved. If one of the following doesn’t help, read on for solutions to specific problems.

- **Reset** iPod shuffle by turning it off, waiting five seconds, and then turning it back on again.
- **Retry** with a different USB port if you cannot see iPod shuffle in iTunes.
- **Restart** your computer, and make sure you have the latest software updates installed.
- **Reinstall** iTunes software from the latest version on the web.

**If iPod shuffle won’t turn on or respond**
- If the status light blinks orange when you press a button, the iPod shuffle buttons are disabled. Press and hold Play/Pause (▶) for about three seconds, until the status light blinks green.
- Connect iPod shuffle to a high-power USB port on your computer. Your iPod shuffle battery may need to be recharged.
- Turn iPod shuffle off, wait five seconds, and then turn it on again.
- You may need to restore iPod shuffle software. See “Updating and Restoring iPod shuffle Software” on page 26.
If iPod shuffle isn’t playing music

- Make sure the earphone or headphone connector is pushed in all the way.
- Make sure the volume is adjusted properly. A volume limit might be set. See “Setting the Maximum Volume Limit” on page 17.
- iPod shuffle might be paused. Try pressing Play/Pause (►II).

If you connect iPod shuffle to your computer and nothing happens

- Connect iPod shuffle to a high-power USB port on your computer. iPod shuffle may need to be recharged.
- Make sure you have installed the latest iTunes software from www.apple.com/ipod/start.
- Try connecting to a different USB port on your computer. Make sure iPod shuffle is firmly seated in the dock. Make sure the USB connector is oriented correctly. It can be inserted only one way.
- iPod shuffle might need to be reset. Turn iPod shuffle off, wait five seconds, and then turn it back on again.
- If there is no status light (or the status light is dimmed) and iPod shuffle doesn’t appear in iTunes or the Finder, the battery may be completely discharged. Let iPod shuffle charge for several minutes to see if it comes back to life.
- Make sure you have the required computer and software. See “If you want to double-check the system requirements” on page 25.
- Try restarting your computer.
- If none of the previous suggestions solves the problem, you might need to restore iPod software. See “Updating and Restoring iPod shuffle Software” on page 26.
- If restoring iPod shuffle doesn’t solve the problem, iPod shuffle may need to be repaired. You can arrange for service on the iPod shuffle Service & Support website at www.apple.com/support/ipodshuffle/service.

If songs load slowly

Connect iPod shuffle to a USB 2.0 port on your computer for fast loading speeds. USB 2.0 loads songs and data faster than USB 1.1.

If you can’t load a song or other item onto iPod shuffle

The song might have been encoded in a format that iPod shuffle doesn’t support. The following audio file formats are supported by iPod shuffle. These include formats for audiobooks and podcasts:

- AAC (M4A, M4B, M4P) (up to 320 kbps)
- MP3 (up to 320 kbps)
- MP3 Variable Bit Rate (VBR)
- WAV
- AA (audible.com spoken word, formats 2, 3, and 4)
- AIFF
A song encoded using Apple Lossless format has full CD-quality sound, but takes up only about half as much space as a song encoded using AIFF or WAV format. The same song encoded in AAC or MP3 format takes up even less space. When you import music from a CD using iTunes, it is converted to AAC format by default.

You can have iPod shuffle automatically convert files encoded at higher bit rates (such as Apple Lossless) to 128 kbps AAC files as they are loaded onto iPod shuffle. See “Fitting More Songs onto iPod shuffle” on page 15.

Using iTunes for Windows, you can convert nonprotected WMA files to AAC or MP3 format. This can be useful if you have a collection of music encoded in WMA format.

iPod shuffle does not support Apple Lossless, WMA, MPEG Layer 1, MPEG Layer 2 audio files, or audible.com format 1.

If you have a song in iTunes that isn’t supported by iPod shuffle, you can convert it to a format iPod shuffle supports. For more information, see iTunes Help.

If the chapters in an audiobook play out of order
• Make sure the shuffle switch on iPod shuffle is set to repeat (.repeat) so that the chapters of the audiobook play in order.
• If the chapters were added to iPod shuffle out of order, connect iPod shuffle to your computer and rearrange the tracks using iTunes. See “Arranging the Order of Songs on iPod shuffle” on page 15.

If you want to double-check the system requirements
To use iPod shuffle, you must have:
• One of the following computer configurations:
  • A Macintosh with a USB port (USB 2.0 recommended)
  • A Windows PC with a USB port or a USB card installed (USB 2.0 recommended)
• One of the following operating systems: Mac OS X v10.3.9 or later, Windows 2000 with Service Pack 4 or later, or Windows XP Home or Professional with Service Pack 2 or later
• Internet access (a broadband connection is recommended)
• iTunes 7.0.2 or later (iTunes can be downloaded from www.apple.com/ipod/start)

If your Windows PC doesn't have a high-power USB port, you can purchase and install a USB 2.0 card. For information, go to www.apple.com/ipodstore.

High-power USB 2.0 port
If you want to use iPod shuffle with a Mac and a Windows PC
Whenever you sync iPod shuffle with a different iTunes library, you must erase the music already on iPod shuffle, regardless of the operating system. When you connect iPod shuffle to a different computer or user account, a message asks if you want to erase iPod shuffle and sync to the new iTunes library.

However, you can use iPod shuffle as an external disk with both Macintosh computers and PCs, allowing you to transfer files from one operating system to the other. See Chapter 3, “Storing Files on iPod shuffle,” on page 19.

Updating and Restoring iPod shuffle Software
You can use iTunes to update or restore the iPod shuffle software. It is recommended that you update iPod shuffle to use the latest software. You can also restore the software, which returns iPod shuffle to its original state.

- If you choose to update, the software is updated but your settings and songs are not affected.
- If you choose to restore, all data is erased from iPod shuffle, including songs and any other data. All iPod shuffle settings are restored to their original state.

To update or restore iPod shuffle:
1. Make sure you have an Internet connection and have installed the latest version of iTunes from www.apple.com/ipod/start.
2. Connect iPod shuffle to your computer.
3. In iTunes, select iPod shuffle in the Source pane and click the Settings tab.
   The Version section tells you whether iPod shuffle is up to date or needs a newer version of the software.
4. Do one of the following:
   - To install the latest version of the software, click Update.
   - To restore iPod shuffle to its original settings, click Restore. This erases all data from iPod shuffle. Follow the onscreen instructions to complete the restore process.
This chapter contains important safety and handling information for iPod shuffle.

Read all safety information below and operating instructions before using iPod shuffle to avoid injury.

Keep this features guide for your iPod shuffle handy for future reference.

Important Safety Information

**WARNING:** Failure to follow these safety instructions could result in fire, electric shock, or other injury or damage.

**Handling iPod shuffle**  Do not bend, drop, crush, puncture, incinerate, or open iPod shuffle.

**Avoiding water and wet locations**  Do not use iPod shuffle in rain or near washbasins, or other wet locations. Take care not to spill any food or liquid into iPod shuffle. In case iPod shuffle gets wet, unplug all cables and turn iPod shuffle off before cleaning, and allow it to dry thoroughly before turning it on again.

**Repairing iPod shuffle**  Never attempt to repair iPod shuffle yourself. iPod shuffle does not contain any user-serviceable parts. For service information, choose iPod Help from the Help menu in iTunes or go to www.apple.com/support/ipod/service. The battery in iPod shuffle is not user-replaceable. For more information about batteries, go to www.apple.com/batteries.
Using the iPod USB Power Adapter (available separately)  If you use the iPod USB Power Adapter (sold separately at www.apple.com/ipodstore) to charge iPod shuffle, make sure that the power adapter is fully assembled before you plug it into a power outlet. Then insert the iPod USB Power Adapter firmly into the power outlet. Do not connect or disconnect the iPod USB Power Adapter with wet hands. Do not use any power adapter other than the Apple iPod USB Power Adapter to charge your iPod shuffle.

The iPod USB Power Adapter may become warm during normal use. Always allow adequate ventilation around the iPod USB Power Adapter and use care when handling.

Unplug the iPod USB Power Adapter if any of the following conditions exist:
• The power cord or plug has become frayed or damaged.
• The adapter is exposed to rain or excessive moisture.
• The adapter case has become damaged.
• You suspect the adapter needs service or repair.
• You want to clean the adapter.

Avoiding hearing damage  Permanent hearing loss may occur if earbuds or headphones are used at high volume. Set the volume to a safe level. You can adapt over time to a higher volume of sound that may sound normal but can be damaging to your hearing. If you experience ringing in your ears or muffled speech, stop listening and have your hearing checked. The louder the volume, the less time is required before your hearing could be affected. Hearing experts suggest that to protect your hearing:
• Limit the amount of time you use earbuds or headphones at high volume.
• Avoid turning up the volume to block out noisy surroundings.
• Turn the volume down if you can’t hear people speaking near you.

For information about how to set a maximum volume limit on iPod shuffle, see “Setting the Maximum Volume Limit” on page 17.

Using headphones safely  Use of headphones while operating a vehicle is not recommended and is illegal in some areas. Be careful and attentive while driving. Stop using iPod shuffle if you find it disruptive or distracting while operating any type of vehicle or performing any other activity that requires your full attention.
Important Handling Information

**NOTICE:** Failure to follow these handling instructions could result in damage to iPod shuffle or other property.

**Carrying iPod shuffle** iPod shuffle contains sensitive components. Do not bend, drop, or crush iPod shuffle.

**Using connectors and ports** Never force a connector into a port. Check for obstructions on the port. If the connector and port don't join with reasonable ease, they probably don't match. Make sure that the connector matches the port and that you have positioned the connector correctly in relation to the port.

**Keeping iPod shuffle within acceptable temperatures** Operate iPod shuffle in a place where the temperature is always between 0° and 35° C (32° to 95° F). iPod play time might temporarily shorten in low-temperature conditions.

Store iPod shuffle in a place where the temperature is always between -20° and 45° C (-4° to 113° F). Don't leave iPod shuffle in your car, because temperatures in parked cars can exceed this range.

When you're using iPod shuffle or charging the battery, it is normal for iPod shuffle to get warm. The exterior of iPod shuffle functions as a cooling surface that transfers heat from inside the unit to the cooler air outside.

**Keeping the outside of iPod shuffle clean** To clean iPod shuffle, remove it from the dock and turn iPod shuffle off. Then use a soft, slightly damp, lint-free cloth. Avoid getting moisture in openings. Don't use window cleaners, household cleaners, aerosol sprays, solvents, alcohol, ammonia, or abrasives to clean iPod shuffle.

**Disposing of iPod shuffle properly** For information about the proper disposal of iPod shuffle, including other important regulatory compliance information, see “Regulatory Compliance Information” on page 31.
Learning More, Service, and Support

You can find more information about using iPod shuffle in onscreen help and on the web.

The following table describes where to get iPod-related software and service information.

<table>
<thead>
<tr>
<th>To learn about</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service and support, discussions, tutorials, and Apple software downloads</td>
<td>Go to: <a href="http://www.apple.com/support/ipodshuffle">www.apple.com/support/ipodshuffle</a></td>
</tr>
<tr>
<td>Using iTunes</td>
<td>Open iTunes and choose Help &gt; iTunes Help. For an online iTunes tutorial (available in some areas only), go to: <a href="http://www.apple.com/ilife/tutorials/itunes">www.apple.com/ilife/tutorials/itunes</a></td>
</tr>
<tr>
<td>The latest information about iPod shuffle</td>
<td>Go to: <a href="http://www.apple.com/ipodshuffle">www.apple.com/ipodshuffle</a></td>
</tr>
<tr>
<td>Registering iPod shuffle</td>
<td>To register iPod shuffle, install iTunes on your computer and connect iPod shuffle.</td>
</tr>
<tr>
<td>Finding the iPod shuffle serial number</td>
<td>Look on the notch underneath the clip on iPod shuffle. Or, in iTunes (with iPod shuffle connected to your computer), select iPod shuffle in the Source pane and click the Settings tab.</td>
</tr>
<tr>
<td>Obtaining warranty service</td>
<td>First follow the advice in this booklet, the onscreen help, and online resources, and then go to: <a href="http://www.apple.com/support/ipodshuffle/service">www.apple.com/support/ipodshuffle/service</a></td>
</tr>
</tbody>
</table>
Regulatory Compliance Information

FCC Compliance Statement
This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation. See instructions if interference to radio or television reception is suspected.

Radio and Television Interference
This computer equipment generates, uses, and can radiate radio-frequency energy. If it is not installed and used properly—that is, in strict accordance with Apple's instructions—it may cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital device in accordance with the specifications in Part 15 of FCC rules. These specifications are designed to provide reasonable protection against such interference in a residential installation. However, there is no guarantee that interference will not occur in a particular installation.

You can determine whether your computer system is causing interference by turning it off. If the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct the interference by using one or more of the following measures:
• Turn the television or radio antenna until the interference stops.
• Move the computer to one side or the other of the television or radio.
• Move the computer farther away from the television or radio.
• Plug the computer into an outlet that is on a different circuit from the television or radio. (That is, make certain the computer and the television or radio are on circuits controlled by different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support information that came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions.

Important: Changes or modifications to this product not authorized by Apple Computer, Inc. could void the EMC compliance and negate your authority to operate the product.

This product was tested for EMC compliance under conditions that included the use of Apple peripheral devices and Apple shielded cables and connectors between system components.

It is important that you use Apple peripheral devices and shielded cables and connectors between system components to reduce the possibility of causing interference to radios, television sets, and other electronic devices. You can obtain Apple peripheral devices and the proper shielded cables and connectors through an Apple Authorized Reseller. For non-Apple peripheral devices, contact the manufacturer or dealer for assistance.


Industry Canada Statement
This Class B device meets all requirements of the Canadian interference-causing equipment regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

VCCI Class B Statement

Korea Class B Statement

Responsible party (Contact for Korean EMC matters only): Apple Computer, Inc. Product Compliance, 1 Infinite Loop M/S 26-A, Cupertino, CA 95014-2084, 408-974-2000.

Industry Canada Statement
This Class B device meets all requirements of the Canadian interference-causing equipment regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

VCCI Class B Statement

Korea Class B Statement

Responsible party (Contact for Korean EMC matters only): Apple Computer, Inc. Product Compliance, 1 Infinite Loop M/S 26-A, Cupertino, CA 95014-2084, 408-974-2000.
Russia

European Community
Complies with European Directives 72/23/EEC and 89/336/EEC.

Disposal and Recycling Information
Your iPod contains a battery. Dispose of your iPod according to your local environmental laws and guidelines.

For information about Apple's recycling program, go to: www.apple.com/environment


China:
警告：不要刺破或焚烧。该电池不含水银。

Nederlands: Gebruikte batterijen kunnen worden ingeleverd bij de chemokar of in een speciale batterijcontainer voor klein chemisch afval (kca) worden gedeponeerd.

Taiwan:
警告：請勿戳刺或焚燒，此電池不含汞。

European Union—Disposal Information:

This symbol means that according to local laws and regulations your product should be disposed of separately from household waste. When this product reaches its end of life, take it to a collection point designated by local authorities. Some collection points accept products for free. The separate collection and recycling of your product at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment.

Apple and the Environment
At Apple, we recognize our responsibility to minimize the environmental impacts of our operations and products.

For more information, go to: www.apple.com/environment

© 2006 Apple Computer, Inc. All rights reserved. Apple, the Apple logo, FireWire, iPod, iTunes, Mac, Macintosh, and Mac OS are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Finder and Shuffle are trademarks of Apple Computer, Inc. Apple Store is a service mark of Apple Computer, Inc., registered in the U.S. and other countries. Other company and product names mentioned herein may be trademarks of their respective companies.

Mention of third-party products is for informational purposes only and constitutes neither an endorsement nor a recommendation. Apple assumes no responsibility with regard to the performance or use of these products. All understandings, agreements, or warranties, if any, take place directly between the vendors and the prospective users.

Every effort has been made to ensure that the information in this manual is accurate. Apple is not responsible for printing or clerical errors.

019-0839/10-2006
Index

A
AAC, converting songs to 15
albums, purchasing 11
Apple earphones 21
arranging the order of tracks 15
audiobooks
  listening to 16
  purchasing 11
audio file formats 24
autofilling 14

B
battery
  charge status 6
  charging 6, 23
  rechargeable 7
  replacement information 27
  status 7
bit rate 15
browsing iTunes Store 10
buttons 4
  disabling and enabling 4, 18

C
charging the battery
  about 6, 23
  using the iPod USB Power Adapter 7
  using your computer 6
compressing songs 15
computer
  charging the battery 6
  connecting iPod shuffle 5
  problems connecting iPod shuffle 24
  requirements 25
connecting iPod shuffle
  about 5
  charging the battery 6
controls
  See also buttons
  using 4
converting songs to AAC files 15
converting unprotected WMA files 25

data files, storing on iPod shuffle 19
disabling iPod shuffle buttons 4, 18
disconnecting iPod shuffle
  about 5
  during music update 5
  eject first 5
  instructions 6
disk, using iPod shuffle as 19
downloading podcasts 11

E
earphones
  See also headphones
  using 21
Eject button in iTunes 6
ejecting iPod shuffle before disconnecting 5
enabling iPod shuffle buttons 4, 18
entering song information manually 12
external disk, using iPod shuffle as 19

F
fast-forwarding 4
features of iPod shuffle 3
fitting more songs onto iPod shuffle 15
formats, audio file 24

G
going to the first track 4

H
headphones, using 21
Headphones port 4
hearing damage, avoiding 28
help, getting 30
higher bit rate songs 15
high-power USB port 5, 6, 23, 24, 25
Index

I
iPod USB Power Adapter 6, 22, 28
iTunes
ejecting iPod shuffle 6
getting help 30
iTunes Store 10
setting not to open automatically 20
version required 25
iTunes Library, adding songs 12
iTunes Store
browsing 10
downloading podcasts 11
purchasing audiobooks 11
purchasing songs and albums 11
searching 10
signing in 10

L
library, adding songs 12
listening to an audiobook 16
loading music
disconnecting iPod shuffle 5
tutorial 30

M
Mac OS X version 25
maximum volume limit, setting 17
music
See also songs; loading music
iPod shuffle not playing 24
purchasing 11
tutorial 30

O
operating system requirements 25
overview of iPod shuffle features 3

P
pausing a song 4
playing
previous song 4
songs 4
songs in order 4
podcasts 10, 11
ports
Headphones 4, 21
high-power USB 5, 6, 23, 24, 25
troubleshooting iPod shuffle connection 24
USB 5, 23, 24
USB 2.0 24, 25
USB on keyboard 5
power adapter 22
Power Search in iTunes Store 11
power switch 4
preventing iTunes from opening automatically 20
problems. See troubleshooting
purchasing songs, albums, audiobooks 11

R
random play 4
rearranging. See arranging
rechargeable batteries 7
reenabling iPod shuffle buttons 4, 18
registering iPod shuffle 30
relative volume, playing songs at 16
replaying songs 4
requirements
computer 25
iTunes version 25
operating system 25
resetting iPod shuffle 4, 23
restoring iPod software 26
rewinding 4

S
Safely Remove Hardware icon 6
safety considerations 27
searching iTunes Store 10
serial number, locating 4, 30
service and support 30
setting play order of songs 4
settings
playing songs at relative volume 16
shuffle songs 16
volume limit 17
shuffle switch 4
shuffling songs on iPod shuffle 4, 16
skipping to next track 4
sleep mode and charging the battery 6
software, updating and restoring 26
songs
arranging the order 15
entering information manually 12
fast-forwarding 4
going to the first 4
pausing 4
playing 4
playing at relative volume 16
playing in order 4
playing next or previous 4
purchasing 11
replaying 4
rewinding 4
shuffling 4, 16
skipping to the next 4
Sound Check, enabling 16
status lights 4, 7
battery 6, 7
storing, data files on iPod shuffle 19
subscribing to podcasts 11
supported audio file formats 24
supported operating systems 25
switches
  power 4
  shuffle 4

T
tracks. See songs
troubleshooting
  connecting iPod shuffle to computer 24
  connecting to USB port 24
  cross-platform use 26
  iPod shuffle not playing music 24
  iPod shuffle not responding 23
  resetting iPod shuffle 4, 23
  safety considerations 27
  updating and restoring software 26
  turning iPod shuffle on or off 4
  tutorial 30

U
unresponsive iPod shuffle 23
unsupported audio file formats 25
updating and restoring software 26
USB 2.0 port recommendation 5, 24, 25
USB port 23, 24
USB port on keyboard 5
USB Power Adapter 22

V
volume
  changing 4
  enabling Sound Check 16
  setting maximum limit 17

W
warranty service 30
Windows
  supported versions 25
  troubleshooting 26
  WMA files, converting 25